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Chapter One
Introduction

GAGEtrak® BEACON, Background Execution and Control software, is a lightweight, service-based system that runs continuously
in the background of a server or an always-on workstation to improve the email notification process.
GAGEtrak calibration management software alone will generate email notices of calibrations that are due, but this requires that
GAGEtrak be run every day, making it a less reliable procedure.
That’s where BEACON takes over. It runs independently from, yet communicates directly with GAGEtrak to improve the
efficiency and reliability of calibration email notices without taking up a single moment of your time or hefty system resources.
After configuring BEACON, no manual intervention is required.
BEACON periodically polls your GAGEtrak database for calibrations that are due, efficiently sends out email notices to calibration
technicians and maintains a complete log of all email transactions.
BEACON begins running at a user-defined start time and continues at an interval of choice. At the scheduled time, BEACON
retrieves the list of gages due for calibration from your GAGEtrak database and then inspects the information, distributing the
gages into a separate sub-list for each specified technician or department (authorized persons).
Once BEACON has compiled a list for each technician, it begins the process of email notification. BEACON retrieves the
technicians’ email addresses from your GAGEtrak database and sends each list to the appropriate person.
If a gage that is due for calibration is not assigned to a particular technician and hence is not included in any of the sublists, that gage can be added to every technician’s list using BEACON’s complete coverage options to ensure that no gage is
forgotten.
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Installation, Activation and Removal
You can use GAGEtrak BEACON on one server and a single workstation, on a network or in a client/server environment;
installation will vary slightly for each of these options. This chapter gives you general installation instructions for all options.

GAGEtrak BEACON Workstation Requirements
•
•
•
•
•
•
•
•

User Guide

Microsoft Windows XP Service Pack (SP) 2 or SP3 or Windows 7
Microsoft .NET Framework version 3.5 (available on the GAGEtrak BEACON CD)
Hard disk drive with 10 MB of free space for program files, plus 100 MB for a typical database
Minimum 1 GB RAM
Pentium 1.4 MHz CPU required; Pentium 2.4 GHz or faster recommended
SVGA monitor at 1024 x 768 resolution or higher
Microsoft Internet Explorer Version 6 or later
Mouse or other compatible pointing device
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GAGEtrak BEACON Server Requirements
•
•
•
•
•
•
•
•
•

Microsoft Windows Server 2003 R2
Microsoft .NET Framework version 3.5 (available on the GAGEtrak BEACON CD)
Hard disk drive with 10 MB of free space for program files, plus 100 MB for a typical database
Minimum 2 GB RAM
Pentium 2.4 GHz or faster recommended
SVGA monitor at 1024 x 768 resolution or higher
Microsoft Internet Explorer Version 6 or later
Mouse or other compatible pointing device
GAGEtrak 6.5 for SQL Server 2005

GAGEtrak BEACON Network Requirements
Optional: This section applies only if the data file will be shared over the network or will be part of a regular network backup.
• 100 MB LAN

Installation
Files
The root directory of the CD contains all the files required to install the BEACON Service and the BEACON Client:

Installation Options
You can use GAGEtrak BEACON in a client/server topology, with one centralized, dedicated computer hosting the service and
one or more user workstations accessing the service on that server. You can also choose to install and use GAGEtrak BEACON
on only one PC (a single-user installation).
If you have a multi-user license for GAGEtrak BEACON, you and your other GAGEtrak users can install the client program
from the CD or from a network location. If you want your users to install from a network location, copy all of the files in the root
directory of the CD to the same network location; then instruct users to run SETUP.EXE from that location.
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BEACON Windows Service Installation
The BEACON Service installer places a Client in the same directory with the BEACON Service and adds a shortcut to the
Program Group. (The BEACON Client only needs to be installed separately if you want the client on a machine other than the
one on which you installed the BEACON service. See the BEACON Client Program Installation section.)
To install the GAGEtrak BEACON Windows Service, follow these instructions:
1. After inserting the GAGEtrak BEACON CD into your CD drive, the Setup Wizard may start automatically; if not,
double-click the Setup.exe file located on the CD within the Service folder.

2. You will now see the Setup Wizard Welcome screen; make sure that you have closed all other programs and then
click Next.

User Guide
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3. The next screen collects your company information. After filling in your company information, click the Next button. If
you do not want to fill in this information at this time, click Next and skip to step 4. You may enter or alter this
information at a later time in the About window.

4. In the Product Registration Information window, enter the serial number associated with your GAGEtrak software.
(You can locate your GAGEtrak serial number by launching GAGEtrak and navigating to Help -> About. The serial
number will be displayed.) Then, click the Next button. If you do not want to fill in this information at this time, click
Next and skip to step 5. You may enter or alter this information at a later time in the About window.
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5. In the Local Service Connection Security window, enable or disable local connections and then click Next:

6. The next window prompts you to choose the location for the program on your hard drive. Because this location is
specific to each workstation, do not select a network location. We recommend using the default directory C:\Program
Files\CyberMetrics\GAGEtrak. After doing so, click Next on this window and the confirmation window to begin the
installation.

User Guide
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7. When installation is complete, click Close.

8. If additional files are required for GAGEtrak BEACON to run, they will install now. Follow the instructions on your
screen to install any additional files.
9. After the installation completes, the program and associated files are installed on your hard drive. If you chose the
default location for the BEACON service, the files are installed in C:\Program Files\CyberMetrics Corp\GAGEtrak
BEACON.
Please note that Technical Support is not available for the creation of your GAGEtrak 6.5 client/server database. That is a
prerequisite for the GAGEtrak BEACON product.
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BEACON Client Program Installation
The BEACON Service installer places a Client in the same directory with the BEACON Service and adds shortcuts to your
desktop and start menu. The BEACON Client only needs to be installed separately if you want the Client on a machine other
than the one on which you installed the BEACON Service.
To install the GAGEtrak BEACON Client program, follow these instructions:
1. To begin installation, click the Windows Start button and select the Run . . . command. Click the Browse button to
navigate to your CD-ROM or network drive and then from the Client folder, select SETUP.EXE.

2. Next, you’ll see the Welcome screen. Make sure that you have closed all other programs and then click Next.

User Guide
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3. The next screen is optional and collects your company information. If you do not want to fill in this information at this
time, click the Next button and skip to step 4.

4. In the Product Registration Information window, enter the serial number associated with your GAGEtrak software.
(You can locate your GAGEtrak serial number by launching GAGEtrak and navigating to Help -> About. The serial
number will be displayed.) Then, click the Next button. If you do not want to fill in this information at this time, click
Next and skip to step 5. You may enter or alter this information at a later time in the About window.
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5. In the Client Configuration window, enter the BEACON Service Host Name and then click Next:

6. The next window prompts you to choose the location for the program on your hard drive. Because this location is
specific to each workstation, do not select a network location. We recommend using the default directory C:\Program
Files\CyberMetrics\GAGEtrak. After doing so, click Next on this window and the confirmation window to begin the
installation.

User Guide
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7. When installation is complete, click Close.

8. The first time you open the client you will need to Activate the product; see BEACON Activation.
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Installation Failure
If, for any reason, you can’t install your software or you receive any error messages during installation, try reinstalling. If
installation fails again, please write down any error messages and call Technical Support at 1-800-777-7020 for assistance.

BEACON Activation
BEACON is an add-on to the GAGEtrak 6.5 family of products and does not allow a demo period. It ships and installs as an
unlicensed add-on that needs to be activated (by obtaining a Trigger Code) before you can use it.

Enter Your Serial Number
If you did not enter your serial number during installation or need to update or correct the serial number, this can be done within
the Product tab in the About window:

Enter your GAGEtrak serial number in the Serial No. field and click the Update Product Serial Number button to save your
changes. (You can locate your GAGEtrak serial number by launching GAGEtrak and navigating to Help -> About. The serial
number will be displayed.)
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Get a Trigger Code
The first time you start the BEACON Client, you will be presented with the license tab in the About window:
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If you have already entered your GAGEtrak serial number in the Product tab, the serial number will be shown in the window
above and you may click the Get Code button to attempt to obtain the trigger code automatically. Depending on your operating
system’s configuration, one of the following will happen:
• If the code appears automatically, the Get Code button changes to Apply Code; click the Apply Code button. No
further action is required.

• If the Trigger Code does not appear automatically, The CyberMetrics website will open in your browser and display the
Trigger Code utility. Most likely, your Trigger Code will be automatically generated and displayed on the web page. (If
your Trigger Code is not automatically generated on the web page, enter the required information and click OK. Your
Trigger Code will then be displayed.) Enter this Trigger Code into the Trigger Code field in BEACON’s License window
(shown above) and click Apply Code.
Once you apply a code successfully, your product is licensed and you may close the About window and continue to setup up
the BEACON Service as described in BEACON Database Connection Configuration.
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Customer Information
The GAGEtrak BEACON installation program collected information used to register the BEACON client software. Within
BEACON, navigate to Help -> About. The About window contains the collected information; these values can be modified.
After changing any information in this screen, click the Update Customer Information button to save the changes.

GAGEtrak BEACON Windows Service Setup
Before starting the service, you must activate your software by obtaining a trigger code, as described in the previous section.
To complete the BEACON Service setup, follow these steps:
1. From the Control Panel, double-click Administrative Tools.
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2. The image below shows a representative screen capture of the Administrative Tools folder. Your list of items might vary
based on the components installed on the system. Double-click the Services item to open the Services Manager.

3. The image below shows a representative screen capture of the Services Manager. Your list of items will vary based
on the components installed on the system. Find the GAGEtrak BEACON service in the list of services and click Start
on the left side of the window.

User Guide

Chapter Two Installation, Activation and Removal

22

Removal
BEACON Windows Service Removal
To remove the GAGEtrak BEACON Windows Service, do one of the following:
• From the Windows Control Panel, click Add or Remove Programs, select GAGEtrak BEACON and then click the
associated Remove button.
OR
• Insert the GAGEtrak BEACON CD; the Setup Wizard opens. Click the Remove GAGEtrak BEACON radio button
and then click the Finish button. You will receive a message that GAGEtrak BEACON has been successfully
removed; click the Close button to exit. All files have been removed with the exception of any log files created
while the service was active and present in the service directory.

BEACON Client Program Removal
To remove the GAGEtrak BEACON client program, do one of the following:
• From the Windows Control Panel, click Add or Remove Programs, select GAGEtrak BEACON Client and then
click the associated Remove button.
OR
• Insert the GAGEtrak BEACON CD; the Setup Wizard opens. Click the Remove GAGEtrak BEACON Client radio
button and then click the Finish button. You will receive a message that GAGEtrak BEACON Client has been
successfully removed; click the Close button to exit. All files have been removed with the exception of any log files
created while the client was active and present in the client directory.
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Chapter Three

Exploring GAGEtrak BEACON
Launching GAGEtrak BEACON
To launch GAGEtrak BEACON, either double click on the GAGEtrak BEACON Client icon that was placed on your desktop during
installation or click the Start button and select All Programs -> GAGEtrak BEACON program group -> GAGEtrak BEACON Client.

Terminology
The Calibration Due List
The Calibration Due list is a subset of all the gages in GAGEtrak database that are defined as follows:
•
•
•
•
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Status must be 1 (Active)
Next Due Date (or Estimated Next Due Date) greater than or equal to the Begin Date specified by the user
Next Due Date (or Estimated Next Due Date) less than or equal to the End Date specified by the user
Next Due Date (or Estimated Next Due Date) cannot be Null
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Audiences
Audiences are the groups of users that receive the due notifications and are defined as follows:
• The Send To audience is defined as the hard-coded list of users specified by the user.
• The Issued To audience is defined as those users that have any qualifying gages in the Calibration Due list
currently issued to them at the time the list is generated.
• The Authorized Persons audience is defined as those users who have any qualifying gages in the Calibration
Due list that are currently related to them.

The All-inclusive Due List
All notification recipients receive the entire listing of Calibrations Due.

The Individually Tailored Due List
BEACON retrieves the list of gages due for calibration from your GAGEtrak database and then inspects the information,
distributing the gages into a separate sub-list for each specified technician or department (Authorized Persons or Issued To).
Once BEACON has compiled a list for each technician, it begins the process of email notification. BEACON retrieves the
technicians’ email addresses from your GAGEtrak database and sends each list to the appropriate person.

The Complete Coverage List
In support of the Tailored Due List function, the system has the ability to send email notifications to any of the audience groups
independently. This independence creates the possibility for some of the due gages to be omitted (not sent to any recipient
within a specified audience). If a gage that is due for calibration is not assigned to a particular audience and hence is not
included in any of the sub-lists, that gage will appear in the Complete Coverage list to ensure that no gage is forgotten.
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Main Menu
Upon starting BEACON Client, the main menu is displayed. This menu shows a navigation menu on the left and the Start page
on the right. A status message displays at the bottom of the window.

User Guide

Chapter Three Exploring GAGEtrak BEACON

26

Gage Operations
Calibration Due List
To view the list of gages currently due, click Calibration Due in the Gage Operations section of the main menu. Within the
Calibration Due form, click the Display Due Gages button to retrieve the current due list. If your database has gages that are
currently due, your window will look similar to the one here:
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How BEACON Works
The BEACON service runs in the background (it is a Windows service). It will begin initial processing at the user-defined Start
Time specified in BEACON Settings and will continue to run based on the Event Interval. The operations that occur at each
interval are detailed below. For detailed information about the settings within GAGEtrak’s Setup -> Auto Email Header window,
please see Chapter Four: BEACON Setup for Administrators.
1. BEACON first communicates with your GAGEtrak database to check for any enabled recipients associated with the
due notification (as set in Setup -> Auto Email Header within GAGEtrak). If no groups are enabled, then BEACON will
not continue with the operation and will remain inactive until the next interval at which time it will recheck the groups.
2. After checking the groups, BEACON will proceed to perform operations for each of the enabled groups individually.
3. BEACON generates the All-inclusive Due List at this point to be used with the following operations. The due list is
created using any customizations made to labels, so the same terminology is used in the email that is displayed within
the GAGEtrak forms.
4. If Send List is enabled (as set in Setup -> Auto Email Header within GAGEtrak), then BEACON performs the
following operations:
• First, the email address for each member of the group is retrieved from the GAGEtrak database and
validated. Members with invalid email addresses are excluded from the current operation and will be
rechecked in every subsequent run.
• If at least one member of the group has a valid email address, then BEACON continues. If the email
address check eliminates all members, then the operation is stopped.
• Because the All-inclusive Due List is sent to every validated member in the Send List, BEACON
generates the email content only once to be used for all send operations. The email consists of the list of
due gages and the text provided in the Email Text section of the Auto Email Header form.
• The BEACON service will send one email to each validated member of the group using the SMTP
Settings and Email Settings information configured in Email Service Settings.
5. If Send Issued To is enabled (as set in Setup -> Auto Email Header within GAGEtrak), then BEACON performs
the following operations:
• First, the email address for each member of the list is retrieved from the GAGEtrak database and validated.
Members with invalid email addresses are excluded from the current operation and will be rechecked in
every subsequent run.
• If at least one member of the group has a valid email address, then BEACON continues. If the email
address check eliminates all members, then the operation is stopped.
• BEACON filters the All Inclusive Due List to obtain a sub-list containing all the due gages that are NOT
issued to any member in the group; this is the Unassociated Complete Coverage List.
• The BEACON service will create one email for each validated member of the group. Each email consists of
the list of due gages issued to that specific member, the Unassociated Complete Coverage List and the
text provided in the Email Text section of the Auto Email Header form.
• The BEACON service will send one email to each validated member of the group using the SMTP
Settings and Email Settings information configured in Email Service Settings.
User Guide
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6. If Send Auth. Persons is enabled (as set in Setup -> Auto Email Header within GAGEtrak), then BEACON
performs the following operations:
• First, the email address for each member of the list is retrieved from the GAGEtrak database and validated.
Members with invalid email addresses are excluded from the current operation and will be rechecked in
every subsequent run.
• If at least one member of the group has a valid email address, then BEACON continues. If the email
address check eliminates all members, then the operation is stopped.
• BEACON filters the All Inclusive Due List to obtain a sub-list containing all the due gages that are NOT
issued to any member in the group; this is the Unassociated Complete Coverage List.
• The BEACON service will create one email for each validated member of the group. Each
email consists of the list of due gages for which that specific member is authorized, the Unassociated
Complete Coverage List and the text provided in the Email Text section of the
Auto Email Header form.
• The BEACON service will send one email to each validated member of the group using the SMTP
Settings and Email Settings information configured in Email Service Settings.
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Chapter Four

Program Conventions
To save time and ensure consistency, the GAGEtrak product family uses a set of program conventions which are standard
commands and design elements that make the different windows and forms operate in the same way.

GAGEtrak Help
Go to the Help menu or press the F1 key to open the BEACON Help System. Select a topic from Contents or use the Help
Topics function to browse an alphabetical list of topics. Use the Back button and Bookmark listing to return to recent topics.

Menus and Commands
File Menu
Command

Description

Exit

To quit BEACON, choose File -> Exit.

Help Menu
Command

Description

Contents

Opens the BEACON Help System.

About

Select this command if you want to see information about the program.

User Guide
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Chapter Five

BEACON Setup for Administrators
BEACON Service Settings
From the main menu, click Settings and then click BEACON Service.

Notification Event Settings

Start Time: This sets the first notification event start time. After the event triggers at this time, subsequent events are based
on the interval and the start time is not used again unless the service is stopped. The field contains the hour of the day (0-23),
followed by minutes (0-59). The default configuration of the service start time is 6:00 AM.
Event Interval: This field determines the frequency of the notification event. The field contains the number of days (0365), followed by hours (0-23) and then minutes (0-59). The default configuration of the service interval is set to deliver the
notifications once every 24 hours (1 day).
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Database Connection Information
Because the BEACON service must communicate with the GAGEtrak database in order to operate, the connection to the
database must be established before the BEACON service can be started. Database connection information is recorded in the
BEACON Service Settings form. The image below shows an example of this information:

When you open the BEACON Service Settings form for the first time, you will notice an error message at the bottom of the
screen indicating a program failure: “The system encountered an exception…” This error is associated with the Notification
Event Settings section and is normal when opening this form for the first time since the database connection has not yet been
established:

If you have installed the BEACON service on the database server (recommended) and used the default GAGEtrak SQL server
database scheme, then the default information should be correct, with the exception of the password. BEACON does not ship
with a password pre-configured; you must enter this information in order to correctly establish a database connection.
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Password Entry: As with most password entry forms, BEACON hides the actual password characters to prevent
eavesdropping and as such demands that you enter the password twice, to ensure that you have entered the correct sequence.
When the 2 entries do not match, BEACON displays the character identifiers in red as shown below:

When the two entries match, BEACON displays the character identifiers in black as shown below:

After entering the connection information, click the save button (pencil icon) to save the connection information:

After the information is saved, the button changes to indicate the information has been saved:
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Email Service Settings
From the main menu, click Settings and then click Email Service.

SMTP Settings
Host Name: In this field, enter the name of the SMTP server that will handle SMTP requests from within your domain. This
identity can be established either by IP address or the fully qualified SMTP service name, i.e., mail.<your company name>.com.
SMTP Port: In this field, enter the remote port your administrator has configured for your SMTP server. The default port for
SMTP is 25.
SMTP Authorization: If the administrator has set up an authentication requirement for within-domain SMTP calls, checking
this checkbox will allow the service to broadcast the credentials supplied with each call to the SMTP server for notification delivery.
• Authorized User ID: In this field, enter the user name specified by the administrator for authentication of remote
SMTP calls to the SMTP server.
• Password Entry: A password is specified by the administrator for authentication of remote SMTP calls to the
SMTP server. The password is NOT read from the configuration storage when the form is displayed to keep it
secured. The password can only be replaced by entering a new password on this form. The password must be
entered twice and a check is made to verify that the entries are identical to ensure that the correct password is
entered. Click the pencil icon to save your entries.
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Email Settings
Address: In this field, enter the email address that will be sent in the notification email as the From Address to help users
identify notifications sent by the service. This address does not need to have an associated email mailbox associated with it,
unless the administrator and users determine that notification recipients will be allowed to respond to notifications by selecting
the Reply and Forward capabilities within their email clients.
Display Name: In this field, enter the display name that will be sent in the notification email as the From Name for email
clients that support this portion of the email specification. As with the From Address, the purpose of this name is to make it
easier for recipients to identify notifications sent by the service.

Calibration Due Settings
From the main menu, click Settings and then click Calibration Due.
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Reporting Days
Check the checkboxes of the days of the week on which you want the BEACON service to run. When a new day is selected,
the service will deliver notifications at 12:00 AM on the new day and then at the specified time interval from 12:00 AM to the
service start time for that day, if the service start time has not already passed.
Similarly, after deselecting a day, the service will not deliver notifications for that day, assuming notifications have not already
been delivered that day.

Complete Coverage
Include complete coverage for the Authorized Persons list: Check this checkbox to include in each email notification
the list of due gages that are not associated with any staff in the Authorized Persons list.
Include complete coverage for the Issue To list: Check this checkbox to include in each email notification the list of due
gages that are not currently issued to any staff members.

Gages Due List Sort Order
In this field, enter the name of the field (column header from the Gage_Master table) by which the due list will be sorted.
The default sort order is DueDate Desc; this means that the list is first sorted by due date and then by description, i.e., the
sorting is performed in the order in which the fields are listed. To sort further, additional fields from the Gage_Master table
can be added after DueDate Desc as a comma-separated list or DueDate Desc can be replaced entirely with another
field(s). In addition to being able to use any field from the Gage_Master database table, two additional fields (DueDate and
DueDateIsEstimate) may also be used in the sort order list.
Column header names may be followed by the direction indicators Asc (ascending) or Desc (descending); if none is provided,
then Asc is assumed.
Regardless of the column headers used here, a BEACON email notification will only include the default information (Gage ID,
Owner, Model No., Description, Current Location and Due Date), unless the email configuration is customized. Please
see Customizing the Email Body for details.

Current Reporting Status
This field will read Enabled for Today and be highlighted in green if <<today>> is enabled in the Reporting Days section;
otherwise, this field will read Disabled for Today and be highlighted in orange.

User Guide

Chapter Five BEACON Setup for Administrators

36

Email Test Mode Configuration
The BEACON service provides a mechanism to put the email delivery into a Test mode that redirects the actual emails into a
folder on the service machine. This allows the administrator or other manager to test the email functionality of the BEACON
service without actually sending to live email addresses. You may inspect these email files in the local folder to ensure that the
content is correct and appropriate for the recipient of the email message.

Enabling Email Test Mode
You must enable the BEACON email test mode manually by editing the configuration file associated with the BEACON service.
Follow these steps to enable the email Test Mode:
1. Locate the configuration file associated with the BEACON service: GAGEtrakBeaconWindowsService.exe.config. If
BEACON was installed in the default location, this file will be located in C:\Program Files\CyberMetrics\GAGEtrak\
BEACON\.
2. Open this file using a text editor such as Notepad.
3. Check if the file already has the email configuration by searching the file for this string: system.net.
• If you find this string and following that line is the ↓mailSettings↑ XML tag, then your configuration file has
the configuration section. Go to step 4.
• If you do not find the string, your configuration file does not have the required section and you will need
to add it. Add the section after the BEACON host service section, which you can find by searching the
configuration file for this string: ↓/BeaconHostedServices↑
4. Ensure that you have the following seven lines in your configuration file. Either adjust the lines you do have (if you
found the search string in Step 3a) or copy and paste these lines immediately after the line you found in Step 3b:

5. After you have made these adjustments/additions, save the file and restart your BEACON service.
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Disabling Email Test Mode
The BEACON email test mode must be disabled manually by editing the configuration file associated with the BEACON service.
Follow these steps to disable the email test mode:
1. Locate the configuration file associated with the BEACON service: GAGEtrakBeaconWindowsService.exe.config.
If BEACON was installed in the default location this file will be located in:
C:\Program Files\CyberMetrics\GAGEtrak\BEACON\.
2. Open this file using a text editor such as Notepad.
3. Check if the file already has the email configuration by searching the configuration file for this string: system.net
• If you find this string and following that line is the ↓mailSettings↑ XML tag, then your configuration file has
the configuration section. Go to step 4.
• If you do not find the string, your configuration file does not have the required section and does not have
the email test mode enabled. Therefore, you may close the file. You do not need to proceed with these steps.
4. If you found the string, be sure that you have the following seven lines in your configuration file:

Either add comment start and stop designators to the lines you do have (see red character in the lines below),
or delete these lines. You would want to use the comment technique if you feel you might need to re-enable the
test mode again to make that step easier.

5. After you have made these adjustments/additions, save the file and restart your BEACON service.
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Changing Email Test Mode Folder
You must change the BEACON email test mode folder manually by editing the configuration file associated with the BEACON
service. Follow these steps to enable the email test mode:
1. Locate the configuration file associated with the BEACON service: GAGEtrakBeaconWindowsService.exe.config. If
BEACON was installed in the default location this file will be located in:
C:\Program Files\CyberMetrics\GAGEtrak\BEACON\.
2. Open this file using a text editor such as Notepad.
3. Check if the file already has the email configuration by searching the configuration file for this string: system.net
• If you find this string and following that line is the ↓mailSettings↑ XML tag, then your configuration file has
the configuration section. Go to step 4
• If you do not find the string, your configuration file does not have the required section. Please refer to the
Enabling Email Test Mode instructions.
4. You should have the following seven lines in your configuration file:

5. Change the test folder location by setting the value of the pickupDirectoryLocation to the location in which you
want the email files to be placed (see the red characters in the lines above). This location MUST exist (create it before
you set this value) and MUST be a physical folder on the same machine on which you installed the service. It is
critical that the location be enclosed in quotes as shown above.
6. After you have made these adjustments/additions, save the file and restart your BEACON service.
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Setup - Email Options
The notification service uses portions of information and structure from the GAGEtrak 6.5 database tables.
Within GAGEtrak, navigate to the Setup -> Settings -> General tab. Three of the settings within the Reports pane are
followed by the BEACON notification service: Start Frequency, End Frequency and Include Past Due.

Start Frequency and End Frequency: Any gage with a calibration due date that falls within this span of time (from <today>)
will be included in the Due Listing and hence, will be included in BEACON notifications.
Checking the Include Past Due checkbox allows BEACON to include all past due calibrations in email notifications.
Additionally, BEACON only includes gages with a Status of 1 (Active) and will not include any gage for which the Next Due
Date and Estimated Due Date fields are empty (null).
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Setup - Auto Email Header
Within GAGEtrak’s Setup -> Auto Email Header window, the selections made for the Automatic Gage Due Listing Email
Event are followed by the BEACON service.

The table below describes the fields on this form:
Field Name

Description

Email Event

There are several pre-defined email events within GAGEtrak. Navigate to the record for the
Automatic Gage Due Listing Email Event. Automatic Gage Due Listing is the name is used by the
system to identify this event and it cannot be modified.

Send List

When selected, a listing of all gages that have calibration due dates within the range specified in
Settings will be sent to each recipient on this list.

Send Auth. Persons

When selected, each person in the list receives an email containing any gages due (within the range
specified in Settings) that he or she is authorized to use. If any gages due are not included in these
individual emails because they’re not associated with an authorized person, then those gages will be
included at the bottom of every email, beneath a dashed line.

Send Issued To

When selected, each person in the list receives an email containing any gages due (within the range
specified in Settings) that are currently issued to that person. If any gages due are not included in
these individual emails because they’re not currently issued to a person in the list, then those gages
will be included at the bottom of every email, beneath a dashed line.

Send Gage Info After Email Body

By default, the Email Text (specified in the Auto Email Header window) will appear at the top of each
email notification. Checking this checkbox makes this text appear at the bottom of each email.

Email Text

This is the body of the notification message and is editable.

Send To List

Use the Employee ID drop-down list to select a staff member to include in the BEACON email
notification service. If any recipient does not have an email address (if it is blank in Staff Entry or
in the case of Issued To gages, the gage is issued out to someone who does not have a Staff Entry
record), the BEACON Service will not attempt to send notification.
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Staff Entry
Email notifications will be sent to individuals who have valid email addresses associated with their Staff Entry information in GAGEtrak:

Issued To and Authorized Personnel Information
Email notifications can be sent to people to whom a gage is issued or to the personnel authorized to use the gage. Within
GAGEtrak, navigate to the Staff Entry -> Issued Gages tab and the Staff Entry -> Authorized Gages tab.

User Guide

Chapter Five BEACON Setup for Administrators

42

Customizing the Gage Due List
This is an overview of how to work with the files that define parts of the forms in the BEACON client. The forms in the BEACON
client have been built using the Microsoft Windows Presentation Foundation (WPF) technology. Individuals interested in performing
the customizations described below will need to be familiar with this technology as well as the XAML file format used by WPF.
The Calibration Due form contains two areas: the Calibration Due Email Service area and the Gages Due for
Calibration area.

The default form provides the gage information fields as shown above. Each of these fields has been set to use only as much
space as the largest entry, so they will expand as needed when the Display Due Gages button is clicked.
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The fields that are included in the list can be changed by adding and removing content from an override file. The override file
must be named DueListCustomPanel.xaml and placed in the same directory in which the GAGEtrak.exe client program has
been installed. Typically, GAGEtrak.exe is installed into C:\Program Files\CyberMetrics\GAGEtrak, but your installation may be
different. Check with the administrator who installed BEACON if you don’t know where GAGEtrak.exe resides.
The following is the content of the sample DueListCustomPanel.xaml.sample file that ships with BEACON.

This sample file duplicates the default list layout and can be used as-is to recreate the default form. To use the sample, remove
the .sample extension from the file name and restart the BEACON client.
Customizations made to this file after renaming will be live the next time the Calibration Due form is opened.
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Customization Example
The following image shows an example of removing a column from the gage list. Specifically, the second column, Model, has
been removed (the highlighted line in the previous graphic).
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Customizing the Email Body
Below is an example of an email sent by GAGEtrak BEACON; the format of BEACON notifications can be customized.

1. To customize the email body, navigate to the directory in which BEACON is installed. Within the Service folder, locate
the GAGEtrakBEACONWindowsService.exe.config file and open it with Notepad.
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2. Toward the bottom of the page, locate the following text and delete the comments that are outlined in red. The text will
only appear like this if you are doing this immediately after installing BEACON.

After deleting the comments, the text will appear like this:

If, for some reason, this is not done immediately after installation of BEACON, then the code will appear like this:

If that’s the case, you will need to add this line at the end of the code prior to </appSettings>:
<add key=”FormatFileName” value=”CalDueReportFormat_text_detail.xslt” />

So, the new code will look as follows:
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3. Save the changes and close the file.
4. Located on your BEACON installation disk is a file named CalDueReportFormat_text_detail.xslt. Open the file
and locate (toward the bottom) the text that is similar to the text below. In this example, there are five fields that display
in the email: Owner, Current Location, Gage ID, Description and Model No.

You can change the order of the fields by cutting and pasting the sections or remove a field by deleting its
section. Below is an example of having removed the Model No field:
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To add a field, copy a section of code and paste it in the desired location within the list and then modify the
label description and the name of the field:

5. Once all desired modifications have been made, save the CalDueReportFormat_text_detail.xslt file and place it in
the Services folder under your BEACON installation directory.
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Accessing the Email Transaction Log
BEACON maintains a complete log all email notifications; the log file (GAGEtrakBEACONWindowsService.Trace.log) is
located in the Service folder of the BEACON installation. Following is an example of various log entries:
----------------header-----------------------Timestamp: 6/19/2012 6:00:02 AM
Message: Within ProcessTimerEvent
Category: Information
Priority: 4
EventId: 0
Severity: Information
Title:
Machine: DESKTOP-003
Application Domain: GAGEtrakBEACONWindowsService.exe
Process Id: 1780
Process Name: C:\Program Files (x86)\CyberMetrics Corp\GAGEtrak BEACON\Service\GAGEtrakBEACONWindowsService.exe
Win32 Thread Id: 3416
Thread Name:

----------------footer---------------------------------------header-----------------------Timestamp: 6/19/2012 6:00:04 AM
Message: RunCalibrationDue: FieldLabels and EmailInfo objects initialized successfully
Category: Information
Priority: 4
EventId: 0
Severity: Information
Title:
Machine: DESKTOP-003
Application Domain: GAGEtrakBEACONWindowsService.exe
Process Id: 1780
Process Name: C:\Program Files (x86)\CyberMetrics Corp\GAGEtrak BEACON\Service\GAGEtrakBEACONWindowsService.exe
Win32 Thread Id: 3416
Thread Name:

----------------footer------------------------
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----------------header-----------------------Timestamp: 6/19/2012 6:00:05 AM
Message: RunCalibrationDue: CalibrationDue email sent successfully from RunCalibrationDue()
Category: Information
Priority: 4
EventId: 0
Severity: Information
Title:
Machine: DESKTOP-003
Application Domain: GAGEtrakBEACONWindowsService.exe
Process Id: 1780
Process Name: C:\Program Files (x86)\CyberMetrics Corp\GAGEtrak BEACON\Service\GAGEtrakBEACONWindowsService.exe
Win32 Thread Id: 3416
Thread Name:

----------------footer---------------------------------------header-----------------------Timestamp: 6/19/2012 6:00:05 AM
Message: Calibration Due Email sent
Category: Information
Priority: 4
EventId: 0
Severity: Information
Title:
Machine: DESKTOP-003
Application Domain: GAGEtrakBEACONWindowsService.exe
Process Id: 1780
Process Name: C:\Program Files (x86)\CyberMetrics Corp\GAGEtrak BEACON\Service\GAGEtrakBEACONWindowsService.exe
Win32 Thread Id: 3416
Thread Name:

----------------footer------------------------
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